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evolution.
When it comes toproductivity, 

we have a few theories of ourown.

You must produce or perish. That’s why ITAC developed the evolution MOUSE-TRAK. 
It’s made for power users like you. People who use a mouse for 8 or more hours at a time and

require a device which eliminates the complex motions caused by “double-click” and 
“click and drag” applications. evolution’s button design saves steps and reduces physical stress. It’s

simple to install, doesn’t need special drivers for operation, and its rugged mechanical 
components assure a long life. Our theory is simple, only the productive survive. Order today.

Visit our web site today to learn more and to enter our Notebook PC Contest. 

ITAC Systems, Inc. 800-533-4822 or 972-494-3073  www.itacsystems.com

Elevated hand
support reduces wrist

fatigue caused by
extended use.

Small footprint —
only half the size of a

mouse pad but 
large enough to support

your hand.

Keys move 
diagonally when

pressed, instead of up
and down — 

providing a smaller,
less tiring motion.

Available for 
USB, SUN 
and PS/2. 

Key position
allows wrist to rotate
to a more “thumbs-

up” position, lowering
wrist fatigue.Single stroke keys

perform most common
mouse actions 

(click, double-click,
and click and drag).

Less movement, 
less confusion, 

more productivity.

© Copyright 2003 ITAC Systems, Inc. 3113 Benton Street, Garland, Texas 75042
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It’s Accurate. But Is It Clear?
Over my many years of writing articles

for magazines, I often get feedback from
readers. Generally it is positive feedback,
but not always—someone always has a bet-
ter way to catch a mouse and they like
telling people. My recent article in the
Jan/Feb issue of AUGIWorld was a water-
shed event. I requested feedback, and boy,
did I get some! 

Let me start this follow-up article by
thanking those readers who took time to
send me their example work: Brian
Britcher, Daniel Curtis, Debbie Foster,
Scott Haugh, Ed Heard, Michael Ishman,
Steven Karp, Matt Miller, Mark Robinson,
and Steve Weber. Thanks to their submis-
sions I had something to write about! I will

toss in bits and pieces of their drawings in
this article. I was surprised that over half of
the submissions had something in 
isometric. Apparently, AutoCAD® has
empowered users to become more adept
in producing complicated drawings. But
are they better looking? All of the submis-
sions were top-notch; care was given to
quality and it shows.

Let me remind everyone what I was
rambling on about last time. After proving
that many AutoCAD terms are based on
traditional drafting methods, I went into
my belief that there is a void in the draft-
ing field now. This void is quality—and the
cause is AutoCAD itself.

Blasphemy!
Now don’t stop reading my article just

yet and start writing one to me. I, as much
as anyone, can appreciate the existence of
AutoCAD and have benefited greatly by
using it.  I love OTTOCAD, as Lynn Allen
calls it, and certainly wouldn’t want to use
anything else. Shall I continue?

The Cad
David Harrington

Manager
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Precision Kills
Did you know AutoCAD has internal

workings that keep your drawing accurate
to 16 decimal places? Considering that a
million is a 1 with 6 zeros after it, going 16
digits the other way is a very small number
indeed. I work in the AEC field doing
structural engineering documents for sta-
diums, convention centers, office towers,
etc. The construction industry uses an
average tolerance of 1" to build stuff. If
they are within 1", they are happy and so is
everyone else. 

So am I saying don’t draw accurately?
Hardly. AutoCAD has 16 decimal places
and I think we should use them to help
make our geometry be spot-on. But are
you putting the same level of care into how
your drawings look? 

1 Picture = 1,000 Decimals
On a given project you have X number

of hours to produce drawings. Now you
can spend this time developing a drawing
file that is so accurate a flea couldn’t pass
through the pixels on your screen. Or you
could spend a few hours here and there
focusing on QUALITY. In the many years
I worked on the board with ink and mylar,
I never once used a magnifying glass to
check a corner. But we do it in AutoCAD
everyday. We zoom in and zoom in, until
the width of that sheathing is 2 inches wide

on the screen. And then we hatch it! It
cracks me up every time. People, if you
can’t see the detail on a sheet of paper—
why bother? Sometimes two lines next to
each other means more than two lines
filled with hatch that plots as a single wide
line because of the hatch density. 

Keeping It Clear
You should, on occasion, change all your

layer colors to white/black. How does your
drawing look? Turn on the lineweights as
well. Do you use them? Unless you plot in
color, a black and white image is what most
of us produce, so why don’t we use those
basic colors on-screen? Because it is easier
to use colors to distinguish layers! Ah, but
have you ever noticed that a lot of users
place text on top of other stuff? This makes
it difficult to read sometimes since the out-
put is black and white.

It is more important to have clear draw-
ings than it is to have accurate digital data.
Did you spend more time making sure that
your drawing was accurate than you spent
making sure it was clear? To be honest, it
happens to me as well. CAD systems typi-
cally are not all that great at conveying on-
screen the final output when plotted, but

rest assured that ?" plate has hatch! I know
you can’t see the hatch at ?" scale, but our
standards say we should hatch it. Again,
accuracy wins over clarity.

In the End
We use AutoCAD to produce drawings.

I know some of you use it to make models
and those models must be to the nth
degree in accuracy, so please don’t write
me about this fact. I would encourage you
to take an unbiased look at your operation.
Are your drawings as good-looking and
clear as they could be? Did you spend any
time at all improving the clarity? If not,
you are either really good or perhaps you
can’t tell—you’re too close. Look at some-
one else’s work then. Next time I will delve
into output specifics like lineweights and
linetypes. As always, feel free to contact
me. Better be nice, though.

David Harrington, Technical Editor for
AUGIWorld, works for Walter P. Moore and
Associates in Tampa, Florida, USA. David is
the author of Inside AutoCAD 2005, Inside
AutoCAD 2002, and original programmer
for REVCLOUD. He can be reached at
david.harrington@augiworld.com.
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Not only are April showers about to usher in
May and a welcome change to warm weather,
but Autodesk® is also rolling out several new
2005 product releases that you’ll want to pay
attention to. These products are packed with new
features, and Autodesk has produced a number
of flipbooks (small, narrow-columned flip charts
that list top features by category for easy refer-
ence) that you’ll want to review. Flipbooks for
Autodesk 2005 products are available now—or
will be soon—through your Autodesk resellers.

But just to whet your appetite, we’ll take a look
at AutoCAD® 2005, drawing upon some of the
tips from the world’s greatest AutoCAD evangel-
ist, Lynn Allen. We’ll also survey a number of tips
and tricks for the latest versions of Autodesk®

Revit®, Autodesk® Architectural Desktop,
Autodesk® Building Systems, and Autodesk® Land
Desktop. There are many more feature enhance-
ments than the ones we’ll be focusing on in this
article, but we’ll highlight some of the key fea-
tures you’ll want to see.

Tips for Getting
The Most from

Autodesk’s New
Releases for 2005

Tips for Getting
The Most from

Autodesk’s New
Releases for 2005



M a y / J u n  2 0 0 4 7

Tips for AutoCAD 2005
One of the flipbooks we mentioned ear-

lier that is bound to become a favorite is
the one authored by Lynn Allen for
AutoCAD 2005. Allen is hands-down one
of the most popular AutoCAD experts.
Few others can de-mystify AutoCAD soft-
ware as well as she can. Allen’s Top 10
include tips for getting the most from the
User Interface, Palettes, Sheet Sets,
Tables, Fields, Express Tools, and others.
We’ll concentrate in this article on Sheets,
Tables, and Fields.

Allen notes that Sheet Sets have been
added to AutoCAD 2005 to help you bet-
ter organize drawing files. Here are some
of the Sheet Set basics.
• Sheets point to a layout in a drawing file.
• You can create several sheets from a

drawing with multiple layouts.
• It’s easy to add, remove, and re-number

each sheet.
• A drawing can belong to only one 

sheet set.
• Multiple users can access and edit a

sheet set at the same time, but only one
user can edit the same sheet.

How do you create sheets? That’s also
easy. Open a drawing file, access the sheet

set manager from the tools menu (or by
pressing Ctrl+4), and select “New Sheet
Set” from the drop-down list. A Sheet Set
Wizard is included to help you set up
Sheet Set parameters.

AutoCAD 2005 also sports a new intelli-
gent Table object. To create Tables, you
first set up your styles in a Table Style dia-
log box in three easy steps.

1. Select Tablestyle from the Format menu.
2. Select New to create a new table style.
3. Set up your table style to reflect your

needs, such as table direction, text
height, alignment, border properties,
and so on.

Once the style is set up, creating your
table is also easy. You do so by Selecting
Table from the Draw menu, select Table
Style, indicate the number of rows and
columns, and then input specific column
width and row height, or you can let
AutoCAD determine it by table size.

Sound easy? It is. And populating the
tables is straightforward. The Tab and

Remember the days of the authorization code when you got
your new AutoCAD software in its box and you called in to
Autodesk to get your “auth code?” This was a number you used
to load your product and it was generated fairly arbitrarily, even
though it was unique to your particular product once it was
recorded by Autodesk and you entered it into your software. If
you needed to load your software onto a laptop for travel or
have a copy on your home PC for those days away from the
office, installing it on other hardware was just a matter of
remembering the authorization code during installation.

These days the authorization code isn’t quite so arbitrary. In
fact, when you activate your software, a random 64-bit number
is generated that is tied to your hardware. This method of acti-
vation has become the standard not only for Autodesk, but for a
number of software developer household names, including
Microsoft, Adobe, Macromedia, and others.

But does having a code tied to your hardware mean that you
can no longer load your Autodesk software on your home PC or
on your laptop? No, it doesn’t. The activation software is con-
figured to allow use on a second computer. Consult your
Software License Agreements to ensure that use on your sec-
ond computer conforms with the parameters of the license.

“But what about my small 10-person office?” you might ask.
“In the past, I’d buy my 10 seats of AutoCAD, but for conven-
ience, I’d take one CD and install AutoCAD on all 10 worksta-
tions. Can I do that now that software is tied to the hardware it
runs on?” The answer to that question is “Yes, you can.” A small
office can go the multi-use standalone software route. In effect,

that allows you to do one install from one CD that has a single
serial number tied to it. An install wizard allows you to associate
each machine with the serial number during first installation—
the verification is done over the Internet—and then you’re
ready to roll.

You still have all the options, including floating licenses,
which you are accustomed to. In the case of floating licenses—
say an office of 50 people in which only 25 people at a time 
are handling the design workload—you still “check in” and
“check out” licenses on your network through the license-
manager software.

The floating license option will be very handy for you class-
room teachers out there because the activation code is main-
tained on the network server rather than on individual
machines. For example, if you were to scrub the hard drives
clean after every class session you teach in a 10-person PC set
up, you’d be erasing the license on each individual PC for which
you had standalone licenses. But with a network install, your
licenses are maintained on the server.

Even though tying the software to hardware through activa-
tion represents a different approach than perhaps some of you
old salts are used to, it’s pretty much all transparent to users. 
To address any questions you might have, Autodesk has set up
a software activation information  page. Check it out at
www.autodesk.com/activation. Here you can download a 
white paper on activation, read a FAQ, register your 
product, and even provide feedback to Autodesk about the 
activation process.

The AutoCAD Sheet Set Manager helps you
effectively utilize the new sheet set feature.

The Insert Table dialog gives you all the
options you’ll need to configure Tables in
AutoCAD.

Product Activation
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arrow keys move across cells. You double-
click a table cell to enter text. You can insert
fields and symbols from the shortcut menu.
And clicking in a table cell permits you to
insert a block from the shortcut menu.

And speaking of Fields, Allen has added
a “bonus tip” on them for the AutoCAD
2005 flipbook. Allen notes that Fields are
equivalent to “smart text” that updates
automatically. You use field data for such
things as dates, sheet numbers, titles, and
so on. Fields can be inserted into text
objects, attributes, or table cells.

You have your choice of three ways to
insert Fields.

1. Select Insert Field in the shortcut menu
when prompted for text in MTEXT,
DTEXT, ATTDEF, and BATTMAN.
Some of these commands also have an
“insert field” button.

2. Press Ctrl+F.
3. Execute the Field command (this will

place the field as MTEXT).

Whichever route you take, the FIELD-
DISPLAY system variable toggles the dis-
play of a gray background for field text.

Editing and updating Fields is also easy.
Double-clicking brings up the appropriate
editing command. And by default, field values
automatically update when you open, save,
plot, eTransmit, or regenerate a drawing.

Lynn Allen has composed many more
tips for AutoCAD 2005. Watch for her on
the speaking circuit, and be sure to ask
your reseller for her flipbook Lynn Allen’s
Top 10 Tips for AutoCAD 2005.

Autodesk
Revit 6

For those of you
involved with archi-
tectural projects,
Autodesk Revit 6 will
doubtless be the tool
of choice for Building
I n f o r m a t i o n
Modeling. But you
might also want to
make full use of
AutoCAD to incorpo-
rate existing DWG
data into your Revit
project (as in a detail
library) or to hand the
project over to a con-
struction documenta-
tion team. You might
also want to use
AutoCAD to work on
other separate, parallel

projects. Autodesk recognizes these needs
with its release of the AutoCAD Revit
Series 2 later this spring. AutoCAD Revit
Series 2 will include AutoCAD 2005 and
Autodesk Revit 6.1 in one package.

But let’s cut right to the chase. How do you
link and import AutoCAD drawings with/into
Autodesk Revit? Simple. From the File
menu, select Import/Link>DWG,DXF,DGN
… And that’s all there is to it. Like XREF,
links are updated each time the Revit proj-
ect is opened. Imports are “fixed” at the

time of the import.
As for Scaling, Revit will attempt

to determine the correct import scale for
you, but you may need to override it.

How would you use your
AutoCAD/Revit combo to determine true
north? This need comes up often in site
planning where a surveyor provides DWG
or DXF files. Revit’s shared coordinate sys-
tem can define true north based on the
surveyor’s file.

How would you do this?
1. Link the DWG or DXF site plan into

your project.
2. Position the DWG relative to your project.

3. Use Tools > Locations and Coordinates
> Acquire Coordinates. Select the
DWG.

4. In View Properties Orientation: True
North orients the view so the Y axis and
the DWG file points up. Project North
uses the original orientation.

Once you get AutoCAD drawings into
Revit, how can you get Revit objects on the
right AutoCAD layers? You might also want
to have better control of the lineweights
you’ve imported. Here’s what you do.
• File > Import/Export Settings > Export

Layers DWG/DXF.
• File > Import/Export Settings > Import

Line Weights DWG/DXF.

Not too complex, right?
There’s obviously more to cover in how

to work seamlessly with AutoCAD 2005
and Autodesk Revit, and the inimitable
Lynn Allen has once more come to the res-
cue with her Top 10 Tips for the AutoCAD
Revit Series. This is available as a handy
flip-book from your Autodesk reseller. But
before we leave our cursory glance into
Autodesk Revit, let’s survey some of the
Time Savers that Allen includes among the
Top 10. First, some tips for how to “get
around quickly” in Revit.
• DynView is similar to Realtime Pan and

Zoom and 3D Orbit in AutoCAD. You
can start the DynView from a button on
the toolbar or by pressing F8. If you
have a mouse with a scroll wheel, you
can use it as a shortcut to activate the
DynView directly.

• You can Pan (called Scroll in Revit) by
pressing down on the wheel button and
moving the mouse.

• You have three ways to Zoom In and
Zoom Out.

1. Simply roll the mouse wheel.
2. Hold the Ctrl key down while
pressing down on the wheel and
rolling (watch out—this is a rapid
zoom).

3. Hold down Ctrl/middle mouse
button and the move the mouse (if you
don’t have a wheel).

Let’s wrap up our look at Autodesk Revit
with some tips for object selection. As you
move your mouse in the graphic window,
elements under the cursor “pre-highlight”
and turn gray. To change the selection can-
didate, press the TAB key once. When
objects are selected, use the Filter button in
the Option Bar to select all objects of a cer-
tain category (walls, windows, and so on).

You can also select many related objects
via a chain select. Say you have a series of

Use Field data to update dates, sheet numbers, titles and so on.The
Field dialog makes doing this easy.
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joined walls. Just place the cursor over a sin-
gle wall and press the TAB key. The chain of
all other joined walls will pre-highlight. You
can now modify the entire chain.

You can get a more comprehensive col-
lection of tips by asking your Autodesk
reseller for Lynn Allen’s Top 10 Tips for the
AutoCAD Revit Series.

Autodesk Architectural
Desktop 2005

Given that AutoCAD 2005 is at the
heart of Autodesk Architectural Desktop,
many of the new features already
described for AutoCAD also apply to
Autodesk Architectural Desktop. One of
the changes to Architectural Desktop
you’ll want to make a note of, however, is
the inclusion of the new VIZ Render visu-
alization tool, first introduced with
Autodesk Architectural Desktop 2004.
Because of its robust nature, this tool does
up the ante slightly on hardware require-
ments. The system requirements are:
• Windows® XP Professional SP 1a or later
• Windows XP Home SP 1a or later
• Windows XP Tablet PC SP 1a or later
• Windows 2000 SP 4 or later
• At least a Pentium 4 or AMD K7 CPU

with 1.4 GHz processor
• 512 MB RAM (but 1GB recommended)
• 1.3 GB free hard disk space for full

installation
• A monitor with 1024X768 resolution

with True Color

Note that Windows 95, 98, and
Windows NT are no longer supported.

VIZ Render does differ from Autodesk®

VIZ by its having been optimized to accept
the data organization from Autodesk
Architectural Desktop in a more efficient
way. The user interface has also been
revised and simplified, making it more
accessible to Architectural Desktop users.

You might also wonder with the advent
of the new AutoCAD Revit Series whether
Autodesk Architectural Desktop and Revit
will be combined as a single product in the
future. The short answer—the technolo-
gies are too different and there are no
plans to combine the two. But that does
not mean file incompatibility. You can
exchange drawing information (2D DWG
files) between the two just as you do in the
AutoCAD program, through the Export
features already described.

Because of its shared ObjectDBX™ data-
base, Autodesk Architectural Desktop is
ideally suited to interoperate with a num-
ber of products in addition to those already
mentioned, including Autodesk Building

Systems, Autodesk Map™, AutoCAD®

Mechanical, Autodesk® Mechanical
Desktop®, and Autodesk Land Desktop.

You won’t see that many differences in
the user interface and general look and
feel from Autodesk Architectural Desktop
2004, but a number of enhancements were
introduced in the last release (more than
300), which are noteworthy. These includ-
ed improvements in ease of use, drafting
and design, construction documentation,
drawing management, and file sharing.

In the areas of drawing management
and project coordination, a new Materials
feature provides graphic and non-graphic
detail to drawings and documentation for
visualization purposes. Extended schedul-
ing functionality will allow you to tag and
to schedule external draw-
ings. The new sheet sets
also have features making
it easy to manage, plot,
and archive sheets.

And in case you’re won-
dering whether Autodesk
plans to continue its devel-
opment of this platform
into the future, the answer
is an unqualified “yes,”
according to Autodesk
reps. There’s a user base of
this product out there that
numbers more than
300,000 (registered), and
some of the improved fea-
tures you’ll encounter in
the 2005 product family are already under
the enhancement microscope for future
releases. These include the UI, customiz-
able tool palettes, direct object manipula-
tion, construction detailing, integrated
photorealistic rendering and animation
and the like.

Autodesk Building 
Systems 2005

Building systems engineers have a
tool created especially for

them in the

Autodesk Building
Systems product. The 2005 version of this
product is packed with a number of time
savers, and you’re in luck. Those flipbooks
we’ve been describing have a version that

highlights tips and tricks for maximizing
productivity with this product. We’ll take a
look at Tool Palettes in the user interface
along with a number of additional produc-
tivity tips and time savers.

One of the great things about Tool
Palettes is that
they’re customiz-
able. Moreover,
they give you cen-
tralized access to
your most com-
monly used design
tools. Here are
some of the things
you can do with
them.
• Press Ctrl+3 to
display Tool
Palettes.
• To organize it as
you wish, right-
click on the tool
palette bar to select
Customize fromUtilizing Tool Palettes with Autodesk Building Systems

helps simplify HVAC duct work design.

With Autodesk Building Systems standard objects, piping lay-
out couldn’t be simpler.
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the shortcut menu.
• To create tool

palettes that
b e h a v e

exactly like
toolbars, open the

Customize dialog box and
drag buttons from existing toolbars onto

a tool palette.
• To customize a design tool or set up vari-

ous parameters, right-click on the tool and
select Properties from the shortcut menu.

Now is that hard? Hardly, and that’s 
the whole point of palettes—to help make
life easier.

Here are some more UI “time savers”
you might want to consider.

You can customize the Drawing
Window Status Bar by selecting the status
bar drop-down list. Then toggle on or off
the drawing information you want to dis-
play. To change the appearance of a draw-
ing, select the current display configura-
tion shown on the drawing window status
bar, then select a new display configuration
from the drop-down list. And the drawing
window status bar gives you a one-click
option for publishing your drawings.

Here are some new commands that
you’ll encounter with Autodesk Building
Systems 2005 that were designed to help
boost your productivity.

You can use the Isolate Objects com-
mand to hide or isolate specific objects
without having to manipulate layers.
1. Click [the light bulb] on the drawing

window status bar.
2. Select Isolate Objects or Hide

Objects and select the objects to iso-
late or hide.

You can also use the new command
Convert to MvPart to convert 2D
blocks or AEC objects to Building
Systems objects. Here’s all you have
to do.

1. Select Convert to MvPart from an
equipment tool palette.

2. Select the block you wish to convert.
3. Specify a part name, type, subtype, and

layer key to define the MvPart behavior.
4. Add one or more connectors.

The software will update all instances 
of the selected block in the drawing. 
Here are a couple of final tips to help boost
your productivity.

Flip grips is a new feature
that allows you to easily modify isometric
schematic symbols. You select and drag to
change location, rotation, and isometric
plane. You can use the new lengthen grips
feature to stretch or trim duct, pipe, cable
tray, and conduits.

The Layer Manager also now provides
greater functionality. You can use Filters to
group layers and manage them in a new
tree view. You can click the Search box to
quickly find a specific layer.

You can review these tips and discover
quite a few more by contacting your
Autodesk reseller and asking for the Tips
and Tricks for Autodesk Building Systems
2005 flipbook.

Autodesk Land Desktop
As you land managers know, Autodesk

has a suite of tools ideally suited for your
project needs. Each of these products,
Autodesk Land Desktop, Autodesk® Civil
Design, and Autodesk® Survey will have
new 2005 releases.

These products enjoy all the enhance-
ments that are part of AutoCAD 2005 and
Autodesk Map 3D 2005, plus several more
that zero in on land management needs.

The Detail Component Manager in
Land Desktop, for example, will allow you
to take advantage of the Construction
Specifications Institute’s five-digit coding

format for cataloging construction materi-
als. You’ll also be able to combine database
information with XML files to create a
drawing detail of a construction material or
combination of materials in plan, eleva-
tion, or section views.

The LandXML reporting capabilities
have been enhanced and now include two
new reports: Legal Description and Radial
Stakeout. These reports are generated using
LandXML data exported from Land
Desktop. The LandXML Report Generator
is then used to open the LandXML file and
to create the desired report.

There are a number of other improve-
ments. Land Desktop 2005 adds new 
functionality for line, curve, spiral, and
point tables. The Symbol manager now
includes a symbol set for multiview blocks,
which contain both a 2D and 3D represen-
tation. When viewed from 2D, the block
appears as a 2D draft representation. In
3D, the block is suitable for visualization
and rendering.

Both Autodesk Civil Design 2005 and
Autodesk Survey 2005 run on Autodesk
Land Desktop. Civil Design incorporates
all the features of the latest release, 
such as the new reporting, details, and
sheet production available in AutoCAD
2005. Autodesk Survey has a new 

interface for managing and editing sur-
vey control point data. You can also 
flag specific figures to use as surface
modeling breaklines.

Detailed information on what’s avail-
able in the 2005 release of this product
and how it compares with product his-
tory, along with detailed FAQ and
other features information is available
at www.autodesk.com/landdesktop.

Top Ten Tip Books
A number of Autodesk’s 2005 prod-

ucts will have Top 10 flipbooks avail-
able for you. These will be distributed
through the Autodesk reseller channel.
But as always, you can also glean as
much information as you are likely to
need by visiting the Autodesk website
and going to the specific product areas
of the website.

Some of the first 2005 releases are
already on the street, and more prod-

ucts are set to follow soon. You’ll want to
give them all some attention in order to
maximize your design effectiveness.

Arnie Williams, the former editor of CADENCE
magazine, is now a freelance writer specializ-
ing in the CAD industry. He can be reached at
awilliams@grandecom.net.

The Detail Component Manager in Land Desktop pro-
vides many ways of cataloging construction materi-
als, including an option for the Construction
Specifications Institute’s five-digit coding format.
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Autodesk Inventor®

comes with a great
components library, but

since Release 6 and up,
it has been hidden. To find

it, open up an assembly file. In the brows-
er, select the down arrow next to Model
and select Library. Then take a minute to
explore all the great parts available to 
you right at your fingertips. If you upgrad-
ed to Autodesk Inventor R8, you have an
added bonus. In prior releases, these parts
were dumb bodies. In Release 8, these
parts are intelligent Autodesk Inventor
parts. You can edit the parts now to build
up the library.

As if the Standard
Parts Library weren’t
enough, Autodesk has a
partnership with

CADalog.com. You can

access more than eight million (yes, eight
million!) hardware components for use in
Autodesk Inventor on the Internet.

Just use the link below:
http://www.cadalog.com/acad_webparts.php
?username=acad&password=parts

All the parts can be dragged and
dropped from the web page directly into
your assembly using idrop technology.

Release 8 has a new
feature to help you
cope with redundant
constraints. For those

users who get confused
as to what constraints 

have been added and what 
constraints are missing, this can be a 
great help.

To access this option, simply go to Tools-
>Application Options and select the
Assembly tab.

If you enable this option, redundant
constraints will be marked with a symbol in
your model browser.

Starting with Release
8, Autodesk has initiated
a Skill Builders online

training system.
These are FREE training

materials to help users master new features.
To access, go to Help->Autodesk Online
and then select the topic that interests you.
New topics are added regularly, so be sure
to check this every few weeks or so.

If you need to create
a work plane equidis-
tant between two 
parallel surfaces, it is

pretty easy to do.

Step1: Select the work plane tool.

Step 2: Select one face.

Step 3: Select the parallel face.

Step 4: A work plane will be placed equi-
distant between the two selected faces.

Autodesk Inventor R8 has some great tools and features… problem is
that some users may have a hard time discovering them. Sometimes in
the rush to get the job done, we don’t spend the time to explore the
application we are using. When we don’t take a moment to look
around, we miss out on some great features.

1

2

3

4

5

Top 
Autodesk In

Top 
Autodesk In
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Many users become
annoyed because when
they select a workplane
or surface using the

Look At tool, Autodesk
Inventor orients the work-

plane upside down. One way to get your
view to be the way you prefer is to use the
Flip Normal option. Simply select the work-
plane or face, right click and select Flip
Normal. This comes in particularly handy
when you are placing an image or text.

Many times you want
to turn the visibility off
on some of the compo-
nents in an assembly

view. To do this, follow
these steps:

1. Highlight the view in the project 
browser.

2. Right click and select ‘Show Contents’. 

3. Expand the browser. Select the parts
that you want to make invisible. Right
click and select ‘Visibility’ to disable. 

To position a dimen-
sion so it is centered
between its extension
line, try this:

1. Select the
dimension, right click and

select Options->Leader.
2. Now, re-select the dimension, right click

and select Options->Leader.

Voila! The dimension text will 
now be positioned between the two 
extension lines.

To change the 
default isometric view, 
initiate a Common
View Rotate. 

Position the part/
assembly as desired. 

Right click and select ‘Redefine
Isometric’. 

Autodesk Inventor
will automatically
store as many versions
of a file as you want.

The number of ver-
sions of a file are set in

your Projects definition. 

However, your file size can balloon as
your assembly grows. To reclaim the file
and prevent it from becoming corrupted,
you can perform a Purge in Windows
Explorer. Close the file you want to com-
pact in Autodesk Inventor. Locate the file
using Windows Explorer. Right click and
select Purge.

Elise Moss is an author, CAD
instructor, and president of
Moss Designs, creator of cus-
tom applications and designs.
She can be reached at
elise_moss@mossdesigns.com.
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〉〉 Have you ever opened another user’s file and discover the blips

were turned on when you did not want them? Perhaps you found

the UCSICON setting was not as you wanted. These are called

“drawing specific environment settings.”This means that they are

based on variables saved in the drawing file.

There are many types of environment variables. Some are
saved in the registry. Some are saved in, as mentioned
earlier, drawings. Others are not saved at all. Together,

we call these your working environment.
There are myriad variables that affect your environment, far too

numerous to mention here. It is common to hear a new user say,
“How do I turn these things off?” The new user may not have the
savvy to search out a variable that is haunting him or her at a given
time. The seasoned pro, not having used one for a long period 
of time, may have forgotten the command that 
handles an obscure variable. Still, whether you 
know the command name, or need to seek it out, 
it becomes bothersome to ferret out and correct 
the culprit.

Do you prefer to have REGENAUTO on or off?
Did you ever go through a rather complicated mir-
roring operation only to find that the text did not mir-
ror properly? One would need to undo the operation,
reset the MIRRTEXT, and then recreate the original
process. There are times when unwanted environ-

mental settings can be annoying or even waste productivity. A per-
son would rather have everything a preferred way, and not to
wrestle with these issues. There are also times when a standard for
the drawing needs to be adhered to, and it can be somewhat
involved to straighten out an environment that is incorrectly set.

Enter AutoCAD Software’s Script
Scripting can be a very useful and easy-to-learn tool. It is possi-

ble to recreate a myriad of environments to your liking. Scripts are
a handy way to ensure a standard environment.
Scripts are portable, and can serve to automate
certain processes. Scripts do not require complex,
thought-perplexing programming, or the need to
learn a new language. Scripts can often be easier to
create than manually recreating the environment.

Working environments are not the only way
scripts can be useful. Dimstyles, textstyles, and lay-
ering, among others, can be easily and reliably cre-
ated and imported through scripting.

Allow me to give you an example of how very

Scripts are a
handy way to

ensure a 
standard 

environment.
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simple this whole process can be by showing you a dimensioning
variables scripting process.

First, you will need to open a drawing file that has a dimen-
sioning environment set up the way you want it. You may need to
verify all the settings before you begin, perhaps using DDIM.
Next, at the command prompt enter the following:

Command: SETVAR
Enter variable name or [?]: ?
Enter variable(s) to list <*>: DIM*

A listing of the current settings for the dimensioning 
variables is displayed. Press ‘Enter’ as needed until you are
returned to the command prompt. You’re almost done! You
should already see the AutoCAD® text window in front of you,
but if not, press F2. Highlight the listing of dimensioning vari-
ables, including the multiple “Press ENTER to continue:”
prompts, right-click, and select Copy. Start your favorite text
editor and paste in the selection.

While in the text editor, remove any “Press ENTER to contin-
ue:” lines, and any lines that include “(Read only).” Now remove
all but ONE of the spaces between the variable names and their
values. You may even add a command at the end of the script to
save the settings as a named DimStyle. For example:

._DimStyle _s MyDims

Save this file as DIM.SCR
(DOS text only) in a location that
will be easy to find later. You can
name it whatever you wish, so
long as it has the SCR extension.

You can now restore this
dimensioning environment, in
ANY drawing, at the command
prompt simply by entering
SCRIPT, then selecting the
DIM.SCR file. Test the script file
now by loading it. You may get an
error on the variable DimDSep,
for instance. The current value
may be “.”, but the variable only accepts the period without the
quotes. If you get any errors, simply edit the script file to provide
the correct values.

You can further simplify this by including the following line in
your AcadDoc.LSP file:

(defun c:MyDim () (command “._script” “c:/myfiles/dim”))

Of course, your code will need to point to the actual location of
that script where you saved it. If it is saved in a network location,
then other stations can use it, and thus implement this as a stan-
dard. If you are just starting to implement company standards, it
is nice to have this trusty old friend.

Before I go much further, I am certainly aware that this whole
process can be handled through the AutoCAD Design Center. If
you have a template or other drawing with the DIMSTYLE prop-
erly saved, ADC can retrieve it. I would like to mention that it is
my belief that scripting is far faster. The dimensioning environ-
ment might not exist in an easy-to-locate file, yet the script could
be easily loaded.

VIEWRES, BLIPMODE, UCSICON, UCSFOLLOW, HPAS-
SOC, and REGENMODE are only a few examples of where the

environment can be automated by scripting as no other method
can, except by AutoLISP or other programming languages.

What More Can Scripting Do?
Suppose you want to do a global edit to a series of drawings.

Perhaps you want to change copyright labels to the current year.
Perhaps you want to purge all drawings or even SAVEAS them to
an earlier version of AutoCAD. The process of creating the script
can require a bit of thought, but the time savings and unattended
operation can serve in amazing ways.

This can be assisted through a little-known DOS feature called
redirection. This feature allows you redirect the output from a
DOS command to a file. For example, you can redirect the DIR
command, and use the filenames as a framework for creating the
script. You accomplish redirection by using the greater-than sym-
bol (>) after the normal DOS command, and then specifying a
filename. For example:

C:\> DIR /s /b *.dwg > filename.scr

This will place a list of all the drawings located on drive C in a
file named “filename.scr”. The /s option will include subdirecto-
ries. The /b option creates a list of only the filenames (including
their paths). 

A good text editor will allow you create macros. Macros would
simplify the process of adding the commands between the file-

names. The following example will show
you how to globally purge all the drawings:

._OPEN
C:\Temp\Drawing1
._-PURGE
_A
*
_N
._QSAVE
._CLOSE
._OPEN
C:\Temp\Drawing2
…

...and the sequence is repeated for each
drawing in the list. A text editor macro can make short work of
this. Make sure, as you save any script, that it has an extension of
SCR and that it is a “text only” file.

Now you simply launch your script and go to lunch.
If your batch script hangs up anywhere, simply identify where

it left off, knowing that the earlier portions have been done. You
may then edit the original script to start from the drawing where
the script failed after correcting the cause of the error.

The process of Making AutoCAD Scream need not always be in
how you use it or the capacity of your hardware. Often it is how
you THINK. If you think of scripting as easy, you are thinking cor-
rectly. If you think of scripting as a method to keep your attention
away from minute or tedious details that do not need attention,
you are advancing your skills in AutoCAD.

Wayne Hillman is AutoCAD Administrator for
Medallion Homes. He has experience in architecture
and electrical, structural, mechanical, and civil engi-
neering and is a long-time AutoCAD and AutoLISP
user. He can be reached at argutuq@yahoo.com.

The process of Making 
AutoCAD Scream need not

always be in how you 
use it or the capacity 

of your hardware.
Often it is how you THINK.



Vertical transportation in
buildings (stairs, elevators, and
ramps) has long taken a consider-
able amount of design and draft-
ing time to draw and document
adequately. Object-oriented
design applications have strug-
gled with the complexity of stair
construction in particular. 

Stair creation in the first two
releases of Autodesk®

Architectural Desktop bordered
on being painful. Now
Architectural Desktop has a
powerful, flexible, and complete
set of tools for stairs. The latest
release of Autodesk® Revit®, 6.0,
contains stair and railing tools
that are easy to use and—as we
have come to expect—fitted with
an extensive array of parametric
adjustments. 

Straight Stairs and
Landings

To keep things simple, we’ll
create stairs without associating
them with walls or floors. Start a
new project with the default
template. 

From the Modeling tab of the
Design Bar, pick the Stairs tool.
Accept all the default settings.
Autodesk Revit starts in the Run
mode of stair creation. 

Pick a point to start the stairs
and pull the cursor straight up.
Autodesk Revit will display an outline of
the stair, and the cursor will snap to stair
tread distances (11" in this case) out from
the origin point. The default stair length to
reach from Level 1 to Level 2 in this exam-
ple is 15'7". 

Pull the cursor vertically so the tempo-
rary dimension reads 7'4" and left click.
The light gray stair counter located below
the stair run reads 9 RISERS CREATED,
9 REMAINING.

Locate the cursor over the upper 

left corner of the stair run. Pull it vertical-
ly—when it reaches a distance equal to

half the stair
width, Autodesk
Revit will display a
pair of reference
lines and an
Intersection snap.

Left click to
pick the intersec-
tion. Pull the cur-
sor to the left until

the dimension reads 3'8" and
left click.

Locate the cursor over the
upper right corner of the new
run. Pull it to the left to find the
Intersection of the references
as before and left click to start a
run, as before.

Pull the cursor vertically 
to create the third run and 
finish the stairs. The stair 
counter will indicate there are 0
risers remaining. 

Pick Finish Sketch to create
the stair object. Autodesk Revit
displays the stairs with a stan-
dard UP text label and arrow,
break line and railings.

Curved Stairs and
Landings

Besides straight stairs,
Autodesk Revit will readily cre-
ate circular stairs. Putting a
landing in circular stairs takes a
little bit of planning. Here we
aim to create stairs with a 12'

radius to fill a 90° sweep.
From the Basics tab of the Design Bar,

pick Reference Plane. Pick in an open area
of the view screen and pull the cursor to
the right to create a horizontal reference
plane. Create a vertical reference plane
that crosses the first one. Create two more
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Stairway to Heaven:
Stair and Railing Tools in Autodesk Revit

Figure 1

Figure 2 Figure 4

Figure 3
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planes from the intersection of the first
two at angles of 35º and 55º.

Start a stair as in the previous section.
Check the Arc from center and endpoints
option on the Options Bar.

Pick the intersection of the reference
planes for the center of the stair arc. Pull
the cursor to the right until the temporary
dimension reads 12'0" and left click on the
horizontal reference plane to start the
stairs. The actual distance directly along
the reference plane will be slightly more or
less than 12'0" exactly.

Pull the cursor up or down from the
start point. A magenta outline appears and
a temporary arc dimension displays. Note
that the default stair without landing will
fill approximately 74.4 arc degrees.

Pull the cursor up from the origin to the
35° reference plane and pick. The actual
arc distance will not be exactly 35°.

Start the second run by picking the orig-
inal start point a second time to define the
center of the arc. Put the cursor over the
center line of the first run of stairs to pick
up the arc dimension. Pull cursor along the
reference line (arc) that appears to the
intersection of that arc with the 55° refer-
ence plane. Pick that intersection point to
start the second run of stairs.

Pull the cursor to the left and the
magenta stair outline will appear. Left click
to the left of the outline to create the
upper run of stairs at approximately 35°
degrees. The riser counter will read 18

RISERS CREATED, 0 REMAINING.
Pick Finish Sketch to create the 

stair object.

Stair Properties
and Parameters

The stairs you have
just created are of the 7"
max riser 11" tread type,
the only stair type 
available in the default
template and therefore
the basis of all custom
stair types created using
this template. 

Select either set of
stairs in the current 
project. Pick the
Properties icon from the
Options Bar. 

In the Element
Properties dialogue, pick
Edit/New. Study the Type Parameters—
there are 25 that apply to the stair 
dimensions and construction, four for
materials, three for annotation specifica-
tions, and half a dozen to fill in with asso-
ciated data such as manufacturer, model
and cost.

Start a new project using the
Residential-Default template. 

In the new file start a stair, as 
before. Pick Stairs Properties from 
the Design Bar. Note that there are
numerous Residential stair styles defined
in this template.

In the Element Properties dialogue,
pick Edit/New. Study the construction
parameters of the current style—tread and
riser thickness, noting definition and appli-
cation and stringer specifications have all

been differentiated. Pick each of the stair
styles in turn and note the differences.
Cancel out of the Properties dialogue and
Stair tools.

Railing Improvements
Railing controls have also been changed

in the new release. 
Pick on any railing in your open files and

check the Properties.
Pick Edit/New. Note the Edit… values

for the Rail Structure and Baluster
Placement Parameters. Open each of
these in turn. The Baluster Placement dia-
logue allows for more than one type of
baluster, and posts (start, corner, and end)
have controls for placement, hosting and
suppression. Assembling complex railing
structures is reasonably straightforward.

Editing Stair Shapes
Besides using the Run mode when cre-

ating stairs, it is possible to draw the out-
line of a stair manually and fill in the risers.
In most cases it will be easier (as with
sketching walls) to create a stair that is
close to the desired shape, if not exact, and
then edit it afterwards to fit. 

The tutorial exercises included with
Autodesk Revit 6.0 on Stairs and Railings
show effectively how to create a sweeping
staircase with rounded treads from a
straight run, how to fit u-shaped and semi-
circular stairs, and how to use the Stair
Calculator. Work through those and you
can call yourself a qualified Stairmaster.

Christopher Fox is a free-
lance architectural drafter,
an educator, author, and
frequent contributor to
AUGIWorld. He can be
reached at lcfox@archim-
agecad.com.
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Because of the importance 
of family-creation skills, in my last article
(Jan/Feb 2004 AUGIWorld), we outlined a
sequence of steps to generate reliable fam-
ilies. (See Figure 1.) In this article, we will
explore different ways of creating families
for Autodesk Revit projects.

The Easy Way
The easiest way to create a new family is

to copy an already existing one. Simply
open an existing family, modify it as need-

ed, and “save as” to another filename.
Using the “save as” method effectively
requires a consistent naming methodology
or the result is a folder full of ambiguous
family variations. A better way to create
new standard sizes is to add a new “type”
to the existing family. 

Family Types
Most standard families are created in a

series of “types.” A way to think about types
is to consider them as size options. For

example, a casement window may be avail-
able in 2x2, 2x3, 3x3, and 4x4 sizes. In this
example one family has four types within it.

To create a new type within an existing
family, open the family. Click “Family
Types” from the Design Bar. Click New
Type and enter a name. Be sure to set the
dimensions to match the new name. It is
possible to create a type for each possible
standard size. A very long list of standard
sizes (types) can result in larger project
files and very long lists in the Type Selector

Former AutoCAD users often think of Autodesk Revit “fam-
ilies” as AutoCAD Blocks. While this is a useful analogy, it
underplays the importance of families in Autodesk Revit. In
the Revit environment, using “smart objects” like families
provides powerful productivity payoffs such as parametric
variables,automatic/controllable visual appearance in all
views (plan, elevation, section, 3D), visibility variable by scale
(coarse, medium, fine), automatic update of schedules (win-
dows, furniture, equipment) and more.

Family Creation Process
Figure 1



drop-down list. To get around this prob-
lem, we have Type Catalogs.

Family Type Catalogs
When loading a family with a Type

Catalog, it is easy to sort through the cata-
log and load only the specific family type(s)
required within the project. All that is
required is to create a comma-delimited
.txt file listing the different types. There
are some rules to making this all work: 
• The file must be saved in the same folder

as the “master” family and it must have
the same name as the “master family”
(with .txt extension, not .rfa extension). 

• The top-most row describes the column
names and data formats, for example,
Type, Manufacturer, Width, Height.

• The left-most column lists the types. For
example 12x12, 12x18, 36x36. 

• Use decimals, not fractions.
• Do not use single or double quotes as

units are specified separately.
• Data types can be LENGTH, AREA,

VOLUME, or OTHER.
• Units can be INCHES, FEET, MIL-

LIMETERS, CENTIMETERS, or
METERS. 

• Use blank for OTHER. (Project unit
settings will be applied as family loads.)

Figure 2 shows the format of the file.
Note that the TYPE field is implied so the
first row begins with a comma.

In-Place Families
An In-Place family is a family created

directly within a project, rather than sepa-
rately in the family editor. One reason for
an In-Place family is that the building
component will be used only within this
one project, not on multiple projects.
Another reason would be to create a com-
ponent that references geometry within
the project, such as a custom reception
desk that fits around a building column. 

The best uses of In-Place families are
unique items that occur once in a project.
When you update an In-Place family with
changes, copies of the original will not be
updated as with regular families. 

Here is one solution to build the family
referencing project geometry and, at the
same time, have it behave as a regular fam-

ily. Create the views that define project
reference geometry (section, plan, and ele-
vation). Next, export the views as .dwg
files. Then launch the family editor and
use the .dwg files as “underlays” in the dif-
ferent views. When the family is complet-

ed, delete the .dwg files, save the family,
and load the family into the project.

Testing
Creating a family is creating an object

that has behavior. Because of this, it is
important to test the completed family to
be sure it works as intended. Figure 3 is a
checklist for testing a family that will be
used in other projects or by other people.

Future Topics
In future articles we will discuss nested

families, formulas in parameters, shared
parameters, linked parameters, and strate-
gic use of geometry to improve speed.

Bruce Madsen is a project
leader at aecContent
(www.aecContent.com).
He can be reached at 
415-321-1117.
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Figure 2
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Manage Your Files with AutoEDMS™

Call us at 800-325-0425 Fax: (310) 755-6050
2463 208th Street, Torrance, Ca  90501-6238 USA
Email: info@acssoftware.com   Web: acssoftware.com
© 2004 ACS Software, Inc. All rights reserved. AutoEDMS is a trademark of ACS Software, Inc. 

AutoCAD® is a registered trademark of Autodesk, Inc.

Simplify Teamwork
When it’s mission-critical, you need

all the pieces to come together 

perfectly, and fast! AutoEDMS offers

automated revision control, redlining

and custom workflow routing for file

editing, checking and approval of

your AutoCAD® drawings at a 

streamlined pace. As the deadlines

become shorter, it allows your team

to work at their top speed. In a world

of higher and faster demands,

AutoEDMS will be at your fingertips

and growing along with you.

. . . . . . . . . . . . . . . . . . . . . 

Family Testing Checklist
■■■■ Flex the model in all dimensions

■■■■ For hosted families, flex the host
thickness

■■■■ Use unreasonable dimensions for
the test (both large and small)

■■■■ Check visibility in all views

■■■■ Load family to a project and repeat
the tests

■■■■ Make all family types in the test
project
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The Beginning
The most important part of creating

believable outdoor lighting is having great
reference material. Pictures and video can
get you part of the way there, but nothing
can replace the power of observation. Go
outside…take a look around. Getting
acquainted with how colors bleed off cer-
tain types of materials and how shadows
cast under different types of light will
allow you to produce far more believable
results. Reality is our reference.

Modeling
Whether you are importing your models

from AutoCAD® or starting them from
scratch within 3ds max® or Autodesk® VIZ
software, there is one thing that I do right
away to make the modeling process feel
more real…more like sculpting. First, cre-
ate an omni light or a directional spotlight
that covers just the 3D space with which
you are working. This will loosely simulate
the sun position or a single point light
source. This shadow-casting light has noth-
ing to do with the lighting scheme you will

create for the final image. It is intended
only to inspire a more realistic feel for the
object(s) as you are working. Make sure
that your light is an off white, yellowish
colour—such as R: 254 G: 250 B: 226—
and have shadow maps turned on.
Frequent test renders allow you to gain a
general understanding of how light falls
and reacts with your model. This will be
very useful for your final lighting scheme. 

Use parametric objects such as boxes
and cylinders as much as possible, espe-
cially if they are a fair distance from the

Lighting the
Outdoors



camera. It is easier to add detail to your
geometry then it is to subtract it. As your
model becomes more complex, the test
renders, as well as the final render, will
tend to get slower, so be sure to keep your
models as simple and clean as you can.
Only model what you need.
Rely on good materials to
provide detail. 

Materials
Creating great materials

for your 3D models means
making them as convincing
as you can—and nothing is
more convincing then the
real thing. I firmly believe
that digital photographs are
the best place to start. Find
physical buildings or
objects that have the mate-
rial types that you need and
photograph them. 

The benefits to this tech-
nique are twofold. First,
the photographs provide
you with a point of refer-
ence to ascertain just how
light interacts with the
material in a real-world
lighting situation, whether
it is natural or artificial
light. Second, the pictures
will ultimately become the
textures that you apply to
your 3D model. These pho-
tos should be brought into a
paint program, like Adobe
Photoshop, where colour
correction and other image
adjustments can be made.
You can also use the paint
program to generate all the
other maps you need to
increase the realism of your
material such as displace-
ment maps, bump maps,
opacity maps, and dirt and
grime maps. 

Lighting
Lighting is one the hardest parts of cre-

ating a realistic rendering. One of the rea-
sons it is so difficult is that there are many
different ways to approach it, all of which
depend on the look and feel that you are
trying to achieve as well as the tools that
are available to you. Understanding some
of the properties of light will assist us in
attempting to recreate it.

The intensity of a light is basically how
brightly a light illuminates the surface onto

which it is being cast. In the real world, the
intensity of a light falls off in proportion to
the square of the distance from the light’s
point of origin. Objects that are further
away are darker and objects that are closer
are lighter.

The direction of a light also affects the
intensity of the light cast onto an object. As
the surface of your objects incline away
from the light source, less light will hit the
surface, making it appear darker. The sur-
face of your object will begin to receive the
full intensity of the light as it approaches a
zero degree angle of incidence, which is
perpendicular to the light source. 

The colour of light is sort of a dodgy
subject because we mentally correct light
colour so that everything seems to be lit by
white light. This is known as colour con-
stancy. Taking this into consideration,

colour values for light should be subtle to
avoid overly tinting the scene, unless, of
course, it’s intentional.

Ambient light or bounced light is the
light that is reflected off diffuse surfaces or
light that is not cast directly from the light

source. Without some
form of global illumina-
tion system, bounced light
must be faked by using
multiple lights. The global
illumination systems with-
in 3ds max are capable
but can be quite slow with
complex scenes.

There are many third-
party renderers available
for 3ds max and Autodesk
VIZ such as VRay by
Chaos Group. VRay can
calculate bounced light for
you…and quite quickly I
might add. VRay is my
rendering tool of choice
when I need to do fast,
realistic lighting.
Generally, for outdoor
scenes I use a direct light
(key light), which simu-
lates the sun, placed above
and slightly in front of the
main subject of the ren-
dering. I also put in some
non-shadow casting fill
lights wherever they are
needed as well as lights for
background images and
any other objects that are
excluded from the VRay
light calculations. There is
a constant trade off
between speed and quali-
ty so make sure that you
leave yourself enough
time to achieve your goal. 

The End…
Though lighting may

seem difficult at times, it is merely a trans-
lation of what we see everyday using the
tools that our software provides. Study
light…and know your tools. Good luck!

Dwayne D. Ellis is the lead
3d computer animator at
Hrycay Consulting
Engineers, a firm specializ-
ing in Motor Vehicle
Accident Reconstruction.
He is also the founder of
Lifeseyes Studios and can

be reached at dwayne_ellis@yahoo.com.
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Understanding some of the 
properties of light will assist us in

attempting to recreate it.



Summary
Manually comparing the Help>

Command References> System Variables
in AutoCAD® 2000i with 2004, there were
38 new variables and one replaced vari-
able. Also mentioned in that article were
those system variables that the command
SETVAR ? * listed but were not found 
in the command references. These vari-
ables were called ‘undocumented’ in the
first article.

Update
I did not have access to either AutoCAD

2002 or the appropriate websites while
writing the earlier article, and so did not
account for changes made in AutoCAD
2002. Since the first article has been pub-
lished, I have learned from several web-
sites that these seven were added in
AutoCAD 2002:
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〉〉 This article is intended

to supplement and

update my previous
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the Nov/Dec issue of

AUGIWorld on the
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it, I have included a

brief summary.



1) DIMASSOC
2) HALOGAP
3) HIDETEXT
4) OBSCUREDCOLOR
5) OBSCUREDLTYPE
6) TDUCREATE
7) TDUUPDATE

This means that only 31 new variables
were added in AutoCAD 2004, not 38.

Since the system variables had been
previously compared by name only, I over-
looked those whose names remained the
same but the details changed. Access to
two websites gave me a quick method to
find 13 that changed (most have a change
of initial value).

ACISOUTVER initial value
and acceptable values changed

CECOLOR e x p a n d e d
use includes BYBLOCK, and True Color

3-6) CHAMFER (A, B, C, D)
changed initial value from 0.5 to 0

7) DWGCHECK
changed from 2 to 4 toggle values

8) FILLETRAD
changed initial value from 0.5 to 0

9) MAXSORT
changed initial value from 200 to 1000

10) MIRRTEXT
changed initial value from 1 to 0

11) SAVETIME
changed initial value from 120 to 10

12) SHORTCUTMENU
added 16 as an option [this change was not
documented in AutoCAD 2004]

13) SORTENTS
changed initial value from 96 to 127

Regarding the undocumented variables,
I have been informed by Shaan Hurley of
Autodesk and Lee Ambrosius of
Hyperpics.com that the system variables
listed by the command SETVAR ? * are
the ones that each release will accept and
not necessarily the recommend ones for
users to use.

To avoid the need for modification of
customized programs by users, this list

includes those variables which are not
intended for further use and not shown in
the Help> Command Reference. This
inclusion will allow customized programs
to continue operating without revision,
although some variables in those programs
are no longer recommended.

If system variables seem complex to
you, remember that they have three differ-
ent purposes: for users, for developers,
and for Autodesk’s internal use.

The two very helpful websites are
Autodesk’s Beta Programs site:

http: / /betaprograms.autodesk.com/
history/command-map.htm

and Lee Ambrosius’ site:

http://www.hyperpics.com/downloads/resou
rces/customization/autolisp/AutoCAD%20S
ystem%20Variable%20Quick%20Guide.pdf

There are some discrepancies between
the former and the latter. I have used Lee’s
site and thank him for his cooperation in
helping me to obtain that knowledge. In
addition, I want to acknowledge AUGI
member Donnia Tabor-Hanson’s help get-
ting me in contact with the two gentlemen
mentioned above.

Both websites list the system variables 
in tabular form to show which were 
added, changed, or removed in each
release of AutoCAD. 

Jeff Crawford and I hope to have the
indices, posted on www.afralisp.com,
updated soon. These indices can be
accessed and downloaded from the 
LISP tutor tab on the home page 
and then selecting the ‘System 
variables- Alphabetical and Topical 
download’ button.

Gil Hoellerich is a former
telephone company pro-
fessional and teacher. He
frequently writes about
AutoCAD and related top-
ics. Gil can be reached at
ghoellerich@NC.RR.com.
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If system variables seem complex to you,
remember that they have three different 
purposes: for users, for developers, and 

for Autodesk’s internal use.
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AutoCAD® software offers considerable
flexibility in the way you create and edit
your titleblocks. For example, you might
attach your titleblock as an external refer-
ence but store the titleblock data as text
within each drawing. Or you might insert
your titleblock in a template file and then
edit titleblock attributes each time you cre-
ate a new drawing from the template.
Regardless of how you create and use your
drawing titleblocks, you can significantly
automate the process of updating title-
block data by utilizing fields. 

The field functionality in AutoCAD
2005 enables you to include sheet set data
in your drawing titleblocks so that as sheet
and sheet set information changes, the title
block data is always current. To automate
your titleblock data, you must replace the
existing data with field codes. You can
insert field codes using the Field dialog
box that is accessible in most text and
attribute editing tools. The Field dialog
box includes field codes for common data
such as current date, sheet number, and
drawing name. In addition to using the
predefined field codes, you can create your
own fields for a sheet set and then access
them from the Field dialog box.

The following procedures assume that
your titleblock is inserted on a layout of a
template drawing and that the titleblock
contains attribute definitions. Even if 
your situation differs slightly, you can 
apply the general ideas that are included in
these procedures.

Creating Custom
Properties

The Sheet Set Manager in AutoCAD
2005 enables you to define custom proper-
ties that can be used as fields for the entire

sheet set or for individual sheets. For
example, you might create custom 
properties for the project number and
project name, whose values apply to the
entire sheet set. And you might create 
custom properties indicating who drew 
or reviewed a particular sheet, in which
case the properties are owned by each
sheet. All of the custom properties that 
you create are available as field data in
your drawings.
1. In the Sheet Set Manager, right-click on

the sheet set title and choose Properties.
2. In the Sheet Set Properties dialog box,

choose Edit Custom Properties.

3. In the Custom Properties dialog box,
choose Add.

4. In the Add Custom Property dialog box:
• Enter a name for the property.
• Enter a default value for the property.
• Specify if the property is owned by 

the entire sheet set or on a sheet-by-
sheet basis.

The custom properties that you define
in the Sheet Set Manager are available as
sheet set fields in the Fields dialog box. 

Creating a Template
“Sheet” Based on a
Template Drawing

If your title block is
inserted in a template
file, your first instinct
might be to open the
template file and edit
the titleblock from
there. Although this
method will work, it
does not offer you
instant feedback as you
select various sheet set

Automating
Titleblock Data



fields because the template file itself is not
a sheet in the sheet set. The easiest way to
add fields to your titleblock, with the assur-
ance that you are selecting the proper
fields, is to work with it as part of the sheet
set. You will create a new sheet that is
based on your standard template file. To
do this, you must have access to a sheet set.
You can use any existing sheet set and
then, after you update the titleblock to
include fields, you can remove the title-
block sheet from the sheet set. If you have
multiple sheet sets to choose from, consid-
er using a sheet set that utilizes custom
sheet set properties and a sheet creation
template that is appropriate for the major-
ity of your projects. 

You can use the Sheet Set Manager
(SSM) to view or edit the sheet creation
template and custom properties associated
with your sheet set.
1. In the SSM, right-click over the sheet

set title and choose Properties.
2. In the Sheet Set Properties dialog box:

• Verify (or select) the sheet creation
template file (DWT, DWT, or DWS)
and layout containing the titleblock.

• Verify (or create) custom sheet set
properties. For more information see 
Creating custom properties.

3. In the SSM, right-click over the sheet
set title and choose New Sheet.

4. In the New Sheet dialog box, enter val-
ues for the sheet number and title. 
Tip: Use values that are easily recogniz-
able when assigning field codes, such as
“SheetNum” and “SheetTitle”.

5. In the SSM, double-click on the new
sheet to open it in the drawing editor.

Adding Fields to a
Titleblock

After you create a new sheet, which is
identical to the template file containing
your titleblock, you can easily replace the
default attribute values with field codes.

Any titleblock data that worked well as an
attribute is a good candidate for using
fields. When editing attribute definitions,
you might be tempted to use REFEDIT or
BATTMAN. Although these methods
enable you to redefine the attribute defini-
tions, they do not update attribute values
of existing block insertions. If you choose
to use REFEDIT or BATTMAN to add
fields, you must erase the current instance
of the titleblock and reinsert the updated
block. To simplify the editing process and
remove any uncertainty caused by existing
block instances, I strongly recommend
that you explode the titleblock, making

note of its insertion point. You will see all
of the attribute tags and you can double-
click on them for easy editing. 

1. Select the titleblock. 
2. From the Modify menu, choose

Explode.
3. Double-click on an old (non-field)

attribute.
4. In the Edit Attribute Definition dialog

box, right-click in the Default value box
and choose Insert Field.

5. In the Field dialog box, select a field cat-
egory and a field name.
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The field category and name that you
choose depends on the attribute you are
currently editing. For example, if you want
the attribute to display the current date,
you would select the Date & Time field
category and the Date field name. Most of
the fields that you will use for titleblock
data are in the SheetSet field category and
the field names begin with
“CurrentSheet.” Using the CurrentSheet
fields in your titleblock enables AutoCAD
to read the values that apply to any sheet in
which the titleblock is inserted. For exam-
ple, you will probably want attributes that
display the CurrentSheetNumber and
CurrentSheetTitle. 

If you created custom sheet set 
properties, you can access them 
using the CurrentSheetSetCustom and
CurrentSheetCustom field names. Of
these two custom options, the one you
select depends on if the custom property
you created is owned by the sheet set or by
the sheet. A drop-down list enables you to
see all of the available custom properties.
For example, if you created a custom sheet
set property called Project Name, which is
owned by the sheet set, you would select
the CurrentSheetSetCustom field name
and then select Project Name from the
Current Property Name list. For more
information, see the Creating Custom
Properties section in this article.

As you apply fields to your attribute def-
initions, you receive instant feedback by
seeing the appropriate value displayed in
the Edit Attribute Definition dialog box. If
you do not see a value, the sheet set prop-
erty has not been assigned a default value.
You might find it helpful to include gener-
ic default values for all of your sheet set
properties. For example, in the
Description property for a sheet, enter the
words “Sheet Description.” The instant
feedback that you receive during the field
insertion process is the only reason that I

suggest updating the titleblock
drawing as part of a sheet set
rather than editing the template
file directly. If you opened the
template file without it being
part of the sheet set, you would
receive no feedback regarding
sheet set properties and
because it would have no cur-
rent sheet set to read from, the
list of custom property names
would be blank, requiring you
to remember the custom prop-
erty names rather than selecting
them from a list.

Replacing the Old
Titleblock

After you update all of the titleblock
data, you must remove the titleblock draw-
ing from the sheet set and use it to replace
the old sheet creation template. It is a
good idea to verify the file name and loca-
tion of the old sheet creation template
before overwriting it. You can do this by
right-clicking over the sheet set title and
selecting Properties.
1. In the SSM, right-click on the sheet you

have been working on and choose
Remove Sheet. The drawing is still open
but it no longer belongs to the sheet set.

2. From the File menu, choose Saveas.
3. In the Save Drawing As dialog box,

select the appropriate file type (DWT,
DWG, or DWS), and select the sheet
creation template file to overwrite.

4. From the Draw menu, choose
Block>Make.

5. In the Block Definition dialog box,
select the name of the titleblock block
definition.

6. Select all of the objects to include in the
block definition.

7. Specify the basepoint for inserting the
titleblock.
Hopefully you took note of the previous

insertion point prior to exploding the block.
Because you redefined the titleblock

after removing the sheet and resaving the
drawing, there are no current sheet set val-
ues associated with this template drawing
and all of the current sheet set fields dis-
play with # symbols. If you redefine the
block prior to removing the drawing from
the sheet set, the attributes will maintain
the last evaluated field values. This could
be helpful depending on the default field
values that you chose. For example, if the
current sheet number was “SheetNum” as
suggested, it might be helpful to see that
text displayed in your titleblock (as
opposed to seeing ###).  If, on the other

hand, the current sheet number was “01”,
it would be confusing to see that irrelevant
text displayed in your titleblock.

Verifying Titleblock
Functionality

After you replace your previous title-
block template with your new version, you
should verify that all of the titlebock fields
function properly. You can do this by cre-
ating a new sheet using your new template
and then reviewing and editing the associ-
ated titleblock data.

1. In the Sheet Set Manager, right-click on
the sheet set and choose New Sheet.

2. In the New Sheet dialog box, enter a
sheet number and title.

3. In the Sheet Set Manager, double-click
on new sheet to open it. 

4. Verify the titleblock data to ensure that
it displays the correct values.

5. Make changes to sheet and sheet set val-
ues and then regenerate the new sheet
to ensure the values update accordingly.

Once you have verified that your title-
block data updates appropriately you are
good to go! New sheets that you create
using your titleblock will automatically dis-
play the current sheet information and, with
little effort, you can replace the titleblocks
in the existing drawing layouts that you
imported. Simply erase and purge the old
titleblock definition from existing drawings
and insert the new titleblock. You don’t
have to reenter the attribute data because it
is still stored with the sheet set and auto-
matically read by the titleblock fields.

Heidi Hewett is Technical Marketing
Manager at Autodesk, Inc. and a long-time
AutoCAD user. She can be reached at
heidi.hewett@autodesk.com.
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CAD and The Space
Telescope

This time we’re going to discuss the histo-
ry of CAD and its ties to a current newswor-
thy topic, the Hubble Space Telescope.
AutoCAD® and Autodesk® Mechanical
Desktop® played a significant role in the
design and maintenance of the Hubble from
the early ’90s to the present.

Much of the original design work on the
Hubble pre-dated CAD. My first tour on
the project (and my last one “on the board”)
was in 1981-1982. My second tour was in
1992-1993 on COSTAR (Corrective Optics
Space Telescope Axial Replacement), which
is the official name of the famous “eyeglass-
es.” COSTAR was designed and built by Ball
Aerospace in Boulder, Colorado. I’ll let you
in on a little-known fact: I was the one who
broke the Hubble, so they made me come
back and fix it. Now you know. <g>

At the Hubble’s “eyepiece,” four identical
“instruments” about the size of a phone
booth are stacked so that they all have a
common corner in the center. The tele-
scope’s image is projected into all four
instruments at once. Each of the instru-
ments performs a different scientific experi-
ment. They are designed to be replaced with
different instruments over the extent of the
Hubble’s life. I worked on one those instru-
ments, the Goddard High Resolution
Spectrograph (GHRS).

Everybody knows that the Hubble initial-
ly had a focus problem. The GHRS was able
to complete its mission despite the tele-
scope’s optical flaw because it didn’t need a
focused image, it only needed light on the
sensors (the development of these sensors,
called CCDs, led to the digital camera 
you got for Christmas). The other instru-
ments sat idle until the repairs were 
completed. This made GHRS the obvious
candidate to remove and replace with the
famous “eyeglasses.” 

Ten years earlier I made drawings on two
components of the GHRS. The “enclosure”
that everything went into, and the “optical
bench,” an extremely precise composite
material structure which positioned all the
lenses and sensors. The COSTAR enclosure
was an identical bolt-on replacement, but

with different stuff inside. We didn’t have
36-inch scanners then, so I spent a lot of
time manually transcribing drawings. To my
amazement, NASA indicated that it could
and would accept AutoCAD .dwg files as a
standard file format.

The 411 on the Hubble and
the Shuttle

The Hubble has had four successful serv-
icing missions (1, 2, 3a, 3b) and has amazed
the science world and much of the public on
many occasions. In that regard it has taught
us that we don’t know what we don’t know.
Ponderous things are occurring in the uni-
verse that defy our known laws of physics.
We have discovered that the expansion of
the universe is accelerating instead of coast-
ing to a stop as we previously thought. We
now have scientific proof that “extra-solar”
planets (planets around other stars) exist. 
In the pursuit of this type of raw science, it
is impossible to predict what could be 
discovered next.

Service Mission 4, the final servicing of
Hubble, was scheduled for May 2005, but
was officially cancelled on March 10, 2004.
This mission would have placed the crown-
ing jewels on the venerable Hubble’s history.
Engineering advancements in the last 14
years assure that its best science is still ahead
of it. We have already spent $250 million on
new instruments for the Hubble that have
20 times the sensitivity of the ones they
replace. They were scheduled for 
installation on Service Mission 4 and are
ready for delivery.  

Without service, the Hubble will likely
cease to function in 2006, but could possibly
have a critical failure at any time. Without its
regular service mission boost, Hubble will
re-enter in 2013. The long term plan calls
for a controlled re-entry in 2010, like the
Russian MIR, for Hubble’s fiery finale.
Three out of Hubble’s five gyros have failed
(long past their predicted lifetime, I might
add). If one more fails, it will be very diffi-
cult to point the telescope at all. When the
final gyro fails, Hubble will begin to tumble
out of control.

There is no plan to cancel the Space
Shuttle program because of the Columbia

tragedy. The next Space Shuttle launch is
scheduled for March 2005. We still need it
to transport people and continue work on
the International Space Station. The foun-
dation of Director O’Keefe’s decision to can-
cel the final service mission is that it is too
dangerous to travel to the Hubble because
there is no safe refuge in the event of a prob-
lem. Travel to the Space Station on the other
hand, offers a refuge if the shuttle is unable
to return to Earth. Without going into a
course on orbital mechanics, one cannot just
“drive on over” from the Hubble to the
Space Station and wait for rescue.

American Heroes
The Astronaut Corp is strongly in favor of

performing Service Mission 4. They are con-
fident that one of the three remaining shut-
tles is good for one last “hang ten” mission.
These people have no fear. That, in my opin-
ion, shows that the spirit of the good old
space program is still alive. Robert Crippen,
Commander of the first Shuttle to re-enter
the Earth’s atmosphere, is still one of my
personal heroes.

For further reading:
• http://www.cbsnews.com 

Search on “Hubble” for March 14, 2004
“60 Minutes” story.

• http://www.space.com/hubble 
A great Space news site.

• http://hubble.stsci.edu 
Space Telescope Science Institute (opera-
tors of Hubble)

• http://www.cafeshops.com/save_hubble
Save the Hubble T-Shirt

• http://www.jwst.nasa.gov 
James Webb Space Telescope (successor
to Hubble)

The Hubble Is Not Yet Dead!
For an expanded version of this article

and information on how you can keep 
the Hubble alive, please join the discussion
in the AUGI Forums under
Publications>Augiworld.

David Kingsley is senior vice president on the
AUGI Board of Directors and can be reached at
david.kingsley@augi.com.
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